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 DBDOC compiles all your INFI 90 resources into 
a single snapshot file representing your system.

 You can browse the snapshot using Hyperview, 
the DBDOC browser.
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From inside BuildPlus

 Open a project and click View project File button

From a shortcut

 Most users have a shortcut to a shared Hyperview in a 
central location.

 From the Start menu, select Programs | GMCL 
DBDOC | Run Hyperview or Programs | GMCL 
DBDOC Hyperview | Run Hyperview

Multiple Hyperview browser windows

 From inside Hyperview, start more browser windows 
with File | New Window.
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Specify the project file to be opened
Specify the initial document to be displayed
Disable continuous live data collection (See section 2.5)
Specify the default live data update interval

See the documentation for more details.

Hyperview can be launched from the command line.  This 
allows fine-grained control of Hyperview options, and is 
necessary in order to define a shortcut.

From the command line you can
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 Use the File menu to open a project file
 Use File | Recent Project Files to see recently viewed 

files
 Use * on the command line (in a shortcut) to 

automatically open the most recently built project file.  
 Associate project files with Hyperview so they get 

opened automatically
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1. Go to the Start menu, click on Control Panel, locate the Folder 
Options icon and double-click on it. 

2. In the Folder Options, click on the File Types tab. 
3. Click the New button below the Registered File Types.  In the File 

Extension box enter project as the File Type. 
4. Once it is added click the Change button below the File Types 

box. 
5. Select the program to open the file from a list selection. 
6. Browse to C:\Program Files\GMCL\DBDOC\Programs and select 

hyperview.exe as the program to open the file.  

To make Hyperview open when you double-click on an 
project file, do the following:
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 Use the Help menu to automatically bring up 
application help

 Go to the GMCL website (gmcl.com) to access 
online help

 Help | Project File Build Revision tells which 
version of Hyperlink built the current project

 Help | About shows the the Hyperview version
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The browser display has two panes.

Index Pane                      Content Pane
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 Push button to control 
the pane layout.

 Adjust the dividing bar 
between panes.

 Pane preferences are 
saved for next time.
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 On startup the main table of contents is 
in the index pane.

 Click on hotspots (links) in the index 
pane to display documents in the other 
pane.

 Buttons for quick index navigation:

Step through topics Step through links 
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 Highlight | Hotspots 
makes links visible

 Pointing finger cursor 
over hotspots

 Click on a hotspot to 
see all the uses of a 
value in the index 
pane.

Displays graphics, CAD/CLDs, other documents.
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Focus is shown by the colored border 
around the index or content pane.
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Use right-click Make This Topic My 
<Content/Index> Pane Home Page 
on any document.
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 Use the mouse scroll wheel to 
scroll up and down in the index 
and content panes.

 Ctrl+scroll to zoom in index 
pane.

 Ctrl+scroll to move left and right 
in content pane
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 Drag the mouse to make a 
rectangle to zoom in on. 

 Use the toolbar buttons or 
keyboard.

 Manually set the 
magnification factor
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Hyperview history support is similar to that of 
other browsers like Internet Explorer.

Go Back

Go Forward

 The black arrow shows you everything in 
the history.
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 Add bookmarks to any document.
 Share your bookmarks with other Hyperview users.
 Manage your bookmarks.
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Two methods for signal tracing

1. Click on a hotspot in the content 
pane to see its uses in the index 
pane.

2. Double click on a hotspot in the 
content pane to jump directly to 
its source or one of its uses.



Click on hotspots in the index pane to 
display the document in the content pane. 
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Right-click or 
double-click on 
hotspots to trace 
signals without 
the index pane.
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 Double-click on 
a value to jump 
right to its 
source.

 Right-click on a 
value. Select Go 
to Source
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 Double-click on a non-source value to show 
a list of uses.  Choose one. 

 Right-click on a value.  Select Go To Use 
and choose a use to go to. 



Hyperview makes it easy to see all the 
signals that may affect a block, and all the 
signals that are affected by it. 
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• Right-click on a function block and 
choose Show Input Tree For This Block

• All of the input signals for the block, and 
their inputs, are highlighted
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Tree Root
Tree continues on 
other CAD/CLD



• Right-click on a function block and 
choose Show Output Tree For This Block

• All of the output signals for the block, and 
their outputs, are highlighted
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Tree Root

Tree continues on 
other CAD/CLD
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Hyperview makes it easy to search.

 Full text search
 Database search
 Search all titles

The icon will show your most recent search type.
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 Searches all text, on graphics, 
CAD/CLD, AutoCAD drawings.

 Search for a specific word or 
phrase.

 Search for word combinations 
with AND and OR.

 Use wildcards *.
 Limit searches to particular 

kinds of documents.
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Search by tag name or partial 
tag name

Search by tag or trend index

Search by any combination of 
Loop, PCU, Module, Block

Search by description text

Searches the databases for 
blocks and tags. 
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You can specify what information is 
displayed with your search results.
 Show search hit frequency
 Show topic groups hits are found in
 Show Loop, PCU, Module, Block of results
 Limit the number of search hits displayed
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 Display search result 
topics in the browser 
window (double-click)

 Save your search 
results

 Print the search results

 Search again!
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You can step through search results without the 
search results dialog using toolbar buttons.

    Next search hit in topic                  

    Previous search hit in topic

    Next topic in search results

    Previous topic in search results
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 Search All Titles shows results 
interactively.

 DBDOC narrows the search based on 
what you type.
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 Go directly to a specific coordinate on a 
document

 Particularly useful when analyzing error 
reports
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It's easy to display live data on documents.  Use 
these toolbar buttons:

     Turn on live data in autofocus mode

     Turn on live data in continuous mode

     Add a Live Loop Annotation for a specific         
block
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Press        to turn on live data in Autofocus mode.

In this mode, live data is refreshed when you 

 change documents

 move around or zoom in a document

 or click on the camera button

Autofocus mode is the most efficient way to collect 
live data

Values will turn gray when they are considered “stale”
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Press       to turn on live data in Continuous mode.

 Continuous mode updates live data at a set interval

 The update interval can be changed in the Options | 
View dialog

 Continuous mode is automatically turned off when 
you change documents
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 Double-click on the camera to turn off 
Autofocus mode

 Only visible values are fetched – to fetch 
fewer values, zoom in to an area of interest

 Monitor the data load in the status bar
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“Sticky notes” that display live 
data.  Use them to:

 View live data for a single 
block

 View the status of any module 
in the system

 Monitor data from another 
document

Example: track a tag's value 
while viewing its database 
entry
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 Right-click on a hotspot, choose 
Create Live Loop Annotation for 
this Block, then choose the type 
of annotation to make.

 Or, to specify an arbitrary block, 
press the      button, or right-click 
anywhere and choose Live Loop 
Annotation | Create. 
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You can specify the block to monitor.

You can 
quickly find 
tag names to 
monitor.

You can specify the block to monitor.
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Choose the type of 
annotation to create
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The green check 
means all is well.

Other symbols can indicate a problem. 
Check the help for more information if 
you see them.

Problems with the network connection are indicated 
in the status bar.
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You can see all the 
annotations in your 
project at a glance 
in the Annotation 
Manager.

Any annotation can 
be edited or 
deleted here.
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 Plot data from any 
block in the 
system

 Plot groups of 
blocks together

 Plot data from 
non-tagged blocks

 Control data fetch 
rate for each block
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 Display data at 
different resolutions

 Mark points of 
interest with 
timestamps

 Print plots
 Export plot data to 

other applications
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 Press the       
button on the 
toolbar

 Press W

 Select View | 
Watch Window

To open the Watch Window:
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In the browser window:
 Right-click on a hotspot and choose Add This Block 

to the Watch Window
 Right-click on a Live Loop Annotation and select 

Add to Watch Window

In the Watch Window:
 Use the  Add Block button
 Double-click on a blank area of the block list on the 

right side of the Watch Window.
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To edit a block, press 
or double click on the block in the block list.

You can flip the plot vertically
Choose the plot color
Pause data collection

 Specify the Y-Axis range
 Or use the built-in range
 Or have it done automatically
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 Create multiple groups to organize your blocks in 
the Watch Window.

 Name each group whatever you want.
 Blocks in a group are plotted together.
 To add a group press the Add Group button.
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 If you use CIULink to monitor groups of blocks, 
you can import the group into the Watch Window

 Use Import | Group or Import Group button
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Manage groups:

 With the Group menu in the Watch Window

 With the Watch Window toolbar

 By right-clicking a group tab
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 Right-click on a function block on a CAD.

 Choose Add Standard Inputs and Outputs to Watch 
Window.

 Handy for adding groups of blocks to monitor together.
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As you mouse over the 
plot, a crosshair shows 
data and time values.

Click on the plot to make 
a permanent “timestamp” 
marking a plot location.

Navigation Plot 
shows a birds-eye 
view of all data 
collected.
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Set the time-scale to zoom in or out on the data.

Multiple plots in a group can be displayed overlapped 
or separately.
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Right-click on a 
Watch Window 
block and choose 
Go To Source.

The block source 
in the 
configuration is 
displayed.

You can jump directly to a block source or block map 
from the Watch Window.
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There are two shortcut ways to navigate 
your Watch Window data. 

 Create timestamps and 
step through them (or 
jump directly to any 
timestamp)

 Step through data runs
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Click on the plot to create timestamps.

Use these buttons to step through timestamps, and 
jump to specific locations in your data.
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Automatic markers flag the start and end of each data run.

Use these buttons to jump from data run to data run, 
skipping over times when no data was collected.
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The navigation plot shows a birds-eye view of all the 
data that has been collected.

   Drag the red frame to change the 
view in the detailed plot area above.
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The Live Data Status Bar helps you to monitor 
how your system is being used

Outgoing data 
requests per 
second

Incoming 
responses 
per second

Total of all 
watch window 
data on disk
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 CIU is limited to about 20 data fetches per 
second.   

 Multiple Hyperviews share this bandwidth.
 Be aware of your bandwidth use.

Watch Send/s and Recv/s.

  
If Send/s > Recv/s, reduce data load.
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 Pause data collection for a group or 
block by clicking on clock icon.

 Reduce requests from main browser 
window by turning off live data, or 
switching to Autofocus mode. 

 Make sure the Watch Window blocks 
are not updating more often than 
needed.  Increase the update interval 
for groups or blocks.

How to reduce data load:

Collecting
Paused

Autofocus
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 Monitor Data Files

 Avoid collecting data unnecessarily – remember, 
the Watch Window is collecting data even when it 
is not open.

 If necessary, move or delete data files directly.  
The Managing Live Data Load section later in this 
presentation will explain how to do this.
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Press Select Mode, 
then drag the mouse 
to select data.

You can export the 
selected data, and import 
it into a spreadsheet.

Specify an export 
timeslot size.  
Data is saved in a 
CSV file, one 
datapoint per 
timeslot.
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All errors 
shown in tree

Click on an error to 
display it in the 
Hyperview browser
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 Errors are built into the project
 Errors displayed in special browser in Hyperview
 Group, filter, sort errors in useful ways 
 Mark errors for special attention (add star)
 Review errors (add check) and indicate they have 

been seen
 Share error stars and checks with other users
 Hide errors that don’t need attention
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 Press the       
button on the 
toolbar

 Press E

 Select View | Error 
Browser

To open the Error Browser:



69

    Indicates that an error requires attention

    Indicates that an error has been reviewed

    Indicates that an error can be hidden

To manage errors, mark them.   Then show only 
those errors you have marked. 
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To manage errors, mark 
them. Then show only those 
errors you have marked. 

Show only 
Hidden errors

Show only 
Active (not 
hidden) errors

Show all errors
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To manage errors, mark them. Then show only 
those errors you have marked. 

Errors grouped by 
their severity, and 
then by error name

Errors grouped by 
which subsystem they 
are associated with
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You can share error stars and checks with other 
users.  Share the task of reviewing errors.

Include error 
information from 
other users

View and filter based 
on stars and checks 
added by other users



 Many options for showing & hiding information

 View & hide specs, attributes, tag names

 Highlight search hits and hotspots

 Show thumbnails in graphical indexes
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 Press S to show and 
hide specs

 The gray spec boxes 
can be moved around
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 You can enable live specs 
by choosing Enable Live 
Specs from the View Menu

 Turn on live specs by 
clicking the camera under 
layered (gray) specs.

 Fetch live specs by clicking 
the camera icon again.
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Toggle attributes on configuration diagrams by 
pressing A.
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Use Highlight | Search Hits to make it easy to see 
search results in the browser.
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Use Highlight | Hotspots to highlight all the 
hyperlinks on a page
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Vegas Lights are a colorful marquee that highlight 
selected hotspots.  Enable them with Highlight | 
Vegas Lights.
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 Default Date Format – MMDD 
or DDMM

 Show thumbnail image – 
toggles display of thumbnails 
for graphical documents

 Update interval – defines how 
often live data on documents 
is updated

These settings are in Options | 
View.  Some useful options:
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Use Options | Color 
Scheme to set the colors of 
various Hyperview features 
such as annotations and 
search hits.

All colors can easily be set 
back to the default.
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Annotations are like electronic 
sticky notes.  There are two types:

 Text annotations (just text)

 Live loop annotations (live 
block, spec, or module 
status data)
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 Click on        in the toolbar
 Right-click on the document and choose Text 

Annotation | Create 

Annotations can be used as reminders, notes to 
colleagues, or as a way to communicate with 
consultants.

To create a text annotation:
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In the Annotation Manager, you can see all the 
text annotations in your project at once.

To open the Annotation Manager, click 

All the annotations 
are displayed here. 
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All the annotations in your project can be 
searched for particular text strings.
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You can print any document displayed in the browser.  

Dark backgrounds can be 
made white to save ink. 

Zoom in to print part of a 
document.  The zoomed 
portion is indicated.
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 Add a caption to the 
page.

 Choose whether to 
include various features 
on the printout.

These include the basic 
options shown earlier, plus 
other possibilities.
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 Select File | Fast Print from the File menu

 Press P on the keyboard

If you print frequently, use Fast Print. 

The Print dialog choices from the first print will be 
applied to subsequent prints
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 Mark the current topic for printing with Mark for Print | 
Mark <topic> for Printing

 Over a block hotspot, mark the block's index for printing 
with Mark for Print | Mark <block index> for Printing

 Over a link hotspot, mark the linked topic for printing with 
Mark for Print | Mark Linked Topic for Printing

Using the right-click menu, you can mark a topic for later 
printing.  This is convenient for printing many topics at once.
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Later, you can print these marked topics from the File | 
Mark Topic for Printing dialog.  

Marked topics are 
collected here.  
Some or all of them 
can be printed.
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To select an entire category of 
topics for printing:

1. Select a group of topics 
from the Groups list.

2. Click Add Selected 
Topic Group.

The topics will be added to the tree in the Marked Topics 
area.  Expand and uncheck any topics you do not wish to 
print.
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A variety of reports and indexes are 
built into the the project system 
snapshot.

In addition, Hyperview provides 
tools such as the Audit Window and 
Graphics Cross Reference Window.
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 Open the Audit Window with View | Audit Window

 Press        on the toolbar

Lists the blocks, tags, 
input and output 
references and function 
codes on the graphic.

Click on any item to 
highlight it on the 
document.

The Audit Window shows at a glance all the resources used 
in a CAD/CLD or graphic.
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 Checklist for tags
 Check all places a block is 

used on the CAD/CLD or 
graphic

 Verify that a block is used 
consistently

 See the tags on an AutoCAD 
or MicroStation sheet

 On graphics, determine if the 
uses of a tag are spread 
across the page
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Use the PCU Report to see what blocks are exported and 
imported between units. 

Click on any entry in the table 
to see the exports and imports 
between two particular blocks.

To see the PCU Report, 
click on PCUMap.txt in 
the Miscellaneous 
Indices chapter in the 
main table of contents, 
then choose one of the 
PCU Report links.
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The Graphical Block Map is a visual representation of how 
each block in the system is used.  
To view the Graphical Block Map:

Right-click on a 
graphic or CAD/CLD 
and choose Go To 
Block Map 
Choose the Block 
Map link at the start of 
any Module chapter in 
the table of contents
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         Used
           Used in the configuration, but no source (or source not built)
           Used on a graphic, but not sourced in the configuration
           Referenced in a database, but not sourced in the configuration
                    Has no source, but is sourced somewhere in the system
             Exported, but not tagged (blue border)
           Tagged but not exception reported.
       Tagged and exported (black border)
            Block is tagged, but not used
           Completely unused

The Graphical Block Map shows how 
each block in the system is used.  

The Perfect Block: 
tagged, exported, used
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The Tag Index is an index of all the tags in your databases.

To view the Tag Index, select Tag Index in the Databases 
chapter of the table of contents.

Alphabetical 
index of tags

The block associated with each tag 
in each database is shown.
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ABSENT indicates 
a tag is not used in 
this database

Each column lists 
the block for the tag 
in that database.

++<tag name> indicates an 
inconsistent tag. The tag is 
associated with different blocks in 
different databases.  This could be 
a concern.

To find inconsistent tags, 
do a text search for ++



100

Open the Graphics 
Cross-Reference Window 
with Go | Display Cross 
References

Press        on the toolbar

Type X

The Graphics Cross-Reference Window shows all the 
graphics that link to and from a given graphic, plus included 
symbols.

To show the Graphics Cross-Reference Window:
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Graphics that link 
to the one shown

Symbols included 
on this graphic

Graphics that the 
shown graphic 
links to

Click on any item in the Graphics 
Cross-Reference Window to display it 
in the browser.
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 Step through your symbol chapters 
 Bring up the cross-references for each symbol 
 Symbols that are never used will have a blank 

cross-reference page 
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 Step through your graphics chapters 
 Bring up the cross-references for each graphic 
 Entries followed by (not linked) in the Cross-

Reference Index indicate that DBDOC was unable 
to build the graphics called for; either the build was 
incomplete or some of the graphics are trying to link 
to graphics that no longer exist 
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The Function Code Descriptions and Uses index lists and 
links every instance of each function code in your system. 

To view it click on 
Function Codes in  
the table of 
contents.

Click on USES to see an 
index of all the places that 
function code is used. 

Click on the function name 
to see a description of its 
specs and outputs.
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INFI 90 Function Code 1 implements user specified 
piece-wise linear functions. 
 To view the graph right 

on the CAD/CLD, right-
click on a FC1 block, and 
select Show Function 
Graph for Block.

 Press S to view the 
specs on which the graph 
is based.

 The live data will update 
along with live data on 
the underlying CAD/CLD.  
Press      to update on 
demand.
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 Click on Function Code 24 in the Function Code Index 
to see a list of all the Adapt Blocks in the system.

 Right-click Go To Use on an adapt block output tells you 
what block it adapts.  Double-click to jump there.
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Rung blocks are heavily used in some systems, e.g. 
ETSI turbine control systems.

 Press S to display the 
ladder diagram describing 
the rung block function.

 Press       to display live 
input, output, and internal 
values right on the ladder 
diagram. 
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AutoCAD and MicroStation drawings are integrated right 
into the DBDOC snapshot. 

 Tag names are used to build 
these links.

 Live data can be displayed 
AutoCAD and MicroStation 
drawings.

 The phrase-match algorithm 
used for constructing links 
can be modified in 
BuildPlus.  We can also 
customize it, to make sure 
you get the links you want.
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In order to fetch live data to display on documents, 
Hyperview needs to know the location of at least one 
CIUMon server (the DBDOC live data server).

Live loop connections can be configured

 In BuildPlus, and built into the project snaphot (the usual 
and preferred approach)

 In Hyperview, using Options | Live Loop Settings
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 Live data can be displayed on documents in Hyperview.

 Data is fetched from the CIU via one or more DBDOC 
data servers (CIUMon).

 Some systems have one CIUMon server.  Some have 
multiple CIUMon servers.

 Sometime certain CIUMons are available on one 
network (e.g. DCS LAN) and other on another network 
(e.g. business LAN). 

 Usually the settings (i.e. list of data servers) are built 
into the project file.

 Possible to create “Custom” local settings in Hyperview.



 View and manage 
connections to CIUMon data 
servers.

 Settings are usually built into 
the project file, but can be 
configured locally (“Custom” 
settings”)



 Usually one or more 
server lists are built into 
the project (project) file.

 Multiple lists are usually 
for multiple network 
contexts.

 Hyperview can 
autoselect the best list.

 You can define a local 
custom list of servers.

Usually you would use 
the built in settings in the 
project file.



You can see whether servers are connected, blocked, 
unavailable, and also which data requests are being sent 
to each server.  



 No settings are built into the project file.

 You need to override the settings built into the project 
file.

 You want to use a specific CIUMon connected to a 
particular CIU or Serial Port Module.

 The built-in CIUMons settings are not accessible in your 
network context.

Usually settings should be configured in BuildPlus, and 
built into the shared project file.  

However, in some situations, you might need to change 
your personal live loop settings using Hyperview:



 Press “Add”.

 Specify the computer 
name and port for the 
CIUMon server you want 
to connect to.



 Usually Hyperview automatically chooses ports in the 
default port range.

 On occasion, to get through a firewall, you might 
specify a particular set of ports for Hyperview to use 
when talking to CIUMon.



 Hyperview automatically 
routes data requests to an 
appropriate CIUMon (if 
there is more than one).

 In unusual circumstances 
you can force data 
requests for a particular 
Loop (and PCU) to go to a 
specified CIUMon server 
by creating a routing 
preference.



 Loops and PCUs for 
which Hyperview can’t 
get data are displayed.

 If live data is turned on 
in the browser, but there 
are no connected 
CIUMons, you will see 
items here.
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The connection icon in the 
browser's status bar shows the the 
current connection status:

Mouse over the connection icon to see the status of each 
specified connection summarized in a tooltip.

Watch out for these icons.  They 
indicate a communication or 
connection configuration problem.

Project 
Settings

Custom 
Settings
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 – Using built-in settings
 Connection OK – Using local custom settings
 Unable to connect – None of the specified 

connections have been made, or requested data is 
not accessible

 No connections have been specified at all
 Connection blocked – This user or IP is not allowed to 

talk to a CIUMon needed for requested data
 Demo settings – Fake data is being displayed

You may see any of these icons in the toolbar.  Where 
multiple connections have different statuses, the “best” 
status is shown.
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If multiple requests are made for the same data in the 
same update interval, Hyperview combines them.

If multiple Hyperviews request the same data from 
CIUMon in the same interval, CIUMon combines the 
requests before passing them on to the CIU.

Both Hyperview and CIUMon try to compress multiple 
requests for the same data.
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 Use Rovisys OPC90 Server to get 50-100 values per   
second!  Contact GMCL for more information.

 Be aware of the live data load you are creating!

 Know how to minimize your own live data load.

 Use more CIUMon servers if you have multiple CIUs.

 Make use of any serial port modules you may have 
available.

On most systems, live data fetch rate is very limited.  10-20 
values per second per CIU is typical.  Multiple Hyperviews 
may share this bandwidth among themselves and with your 
other applications.

General strategies to cope:
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Fast facts:

 A single CIU can give up to 20 values/s
 Multiple CIUs can give up to 20 values/s each
 Serial port modules can give 80 values/s 
 Rovisys OPC90 Server gives 50-100 values/s

To increase bandwidth:

 Multiplex CIUMon servers to your EWS CIUs using 
OPC90 Servers.  

 Use multiple CIUMon servers
 Use serial port modules as much as possible
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Single CIU

 Will probably be on Ring 1 (unless not possible, 
or main system not Loop 1)

 Limited to 20 values / second
 Non Loop-1 data will be fetched via Loop 1 – be 

aware of increased Loop 1 load
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Multiple CIUs

 You have more than one EWS, connected to 
CIUs on different loops.  CIUMon can share the 
CIU connection with the EWS

 Multiplex CIUMon and EWS using RoviSys 
OPC90 Server Lite Plus.  DOUBLE or TRIPLE 
data rate with new 2010 OPC90 Server .

 10-20% cost of CIU makes its spare bandwidth 
available for DBDOC

 Get up to 20 more values/s in Hyperview for 
each connected CIU
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Serial Port Modules

 SPMs very useful when used with DBDOC
 Each can give up to 80 values / second
 System directly gains throughput, since data 

fetched via an SPM does not load the CIU
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Tips for managing live data load due to blocks you are 
plotting in the Watch Window.

 Watch the Send and Recv numbers in the status bar.  
They show requests and responses per second from 
both the Watch Window and live data on documents.

 Increase the Update Interval in Options | View.
 Pause       data collection for blocks or groups of blocks 

you are not actively trending.
 Increase the block update interval where possible.
 Be aware that Watch Window blocks collect data even 

when the Watch Window is not open.
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 Watch the Send and Recv numbers in the status bar.  
They show requests and responses per second from 
both the Watch Window and live data on documents.

 If Recv < Send, CIUMon can't keep up.  Reduce data 
load.

 Remember that all the Hyperviews sharing a CIUMon-
CIU connection share the available bandwidth.

 View CIUMon statistics for a global picture of how 
multiple Hyperviews are loading a CIUMon.   Use 
CIUMon Options or turn on CIUMonController statistics.
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